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elcome to a whole new way of creating, editing, enhancing, and sharing the

documents you create. Take those file folders full of dot-matrix text-only printed
reports and pitch them. Throw away the whiteout. Leave behind those boring, routine,
ho-hum marketing plans; file the black-and-white mugshot personnel photos; and forget
that you ever had to learn how to use a three-hole punch.

This is all said a bit tongue-in-cheek, but we want you to be ready for something new.
Perhaps you've been using Microsoft Office Word for a long time and you love it—that’s
great. Microsoft Office Word 2007 has something new for you. Maybe you've never re-
ally spent a lot of time creating documents, and you're about to learn the art of creating
complex documents for your new job. Office Word 2007 offers you a powerful, uncom-
plicated but powerful way to find just what you need to accomplish the tasks specific to
your project.

Whether you're a new or experienced Word user, you are about to enter a creative new
world that enables you to produce the high-energy, colorful, professional documents
you envision—all in a fraction of the time it previously took—using a single, multifaceted
and intuitive tool: Microsoft Office Word 2007.

Word 2007 includes many features that make creating professional documents as easy
as possible. You can start your document based on professionally designed templates;
you can apply Quick Styles to the text, charts, and images in your document to ensure a
high-quality look. Another feature enables you to create and save blocks of text you use
repeatedly in your documents, which cuts down on the time you spent typing or copy-
ing and pasting—and reduces the margin for error created when you have to rekey infor-
mation multiple times. These features are just the tip of the iceberg! Before we get into
the new features of Word, though, let’s take a quick look at how far Word has come.

A Quick Look Back: The Origins of Word

Those of us who have been using Word since its beginning in 1983 have a certain fond-
ness for the program. It’s like watching a favorite family member grow...and grow...and
grow.
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The earliest version of Word was revolutionary in that it enabled us to significantly re-
duce much of the repetitive work involved in the tedious tasks we had to perform—for
example, typing the minutes of a board meeting or writing a school essay. With Word,
we could save our files and cut, copy, and paste information we'd already entered, there
were menus and they could be used with shortcut keys and a mouse, greatly speeding
up numerous tasks. Typing a report no longer required correction tape; and we could
make headings stand out (what did we ever do without boldface?) and be sure page
numbers would print in the same spot on every page.

When the first version of Word for Windows was released in 1989, it had only two
toolbars. That was plenty for us at the time. We were thrilled to have that much func-
tionality. When the next version of Word arrived three years later, it had the same two
toolbars, but new nested dialog boxes provided an expanded range of choices for the
documents we created.

Then came a period of enormous growth in functionality and features (see Table 1-

1). Between 1989 and 2003, Word exploded, feature-wise. Users loved having a huge
range of choices for their documents, and having a word processing program that
could “do it all” was a definite plus when you were responsible for producing many
kinds of documents. But all this power and flexibility came at a price. The previous
version of Word, Word 2003, has 31 toolbars, 19 task panes, context menus, dockable
menus, hierarchical menus, and expanding menus. How in the world will you find the
commands you need in order to accomplish what you set out to do today? If the docu-
ment you're creating is something you've done a dozen times before, you already know
where the commands you need are located—but what if you're trying something new?
How will you find just what you need? Better leave yourself plenty of time for
exploration.

Table 1-1 The Growth of Word

Release Screen resolution Toolbars Added Features

Word for 640 x 480 2

Windows 1.0

(1989)

Word for 640 x 480 2 Nested dialog boxes

Windows 2.0

(1992)

Microsoft 800 x 600 8 Right-click contextual menus, Tooltips,
Word 6.0 tabbed dialog boxes, toolbars on bottom of
(1994) screen, wizards

Microsoft 800 x 600 9 Auto spell-check, Auto features (such as
Word 95 AutoCorrect)

(1995)

Microsoft 1024 x 768 18 Toolbars all around screen and floating,
Word 97 redockable menu bar, multilevel context
(1996) menus, icons on menus, grammar check-

ing, hierarchical pull-down menus, Office
assistant
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Release Screen resolution Toolbars Added Features

Microsoft 1024 x 768 23 Expanding menus, default toolbars on a
Word 2000 single row, help pane

(1999)

Microsoft 1024 x 768 30 Task panes, Type a question for help box,
Word 2002 Smart Tags, Paste options

(2001)

Microsoft 1024 x 768 31 11 new task panes; Research features
Word 2003

(2003)

As you will see in this chapter and throughout the book, the 2007 release of Word
makes it easier to access what's really important in a first-class word processing pro-
gram. Great features have been there all along, and some were easier to find than oth-
ers. But by simplifying the entire user interface, bringing just the right tools to you
when you're working on specific tasks, and offering a large collection of professionally
designed themes, color palettes, and galleries of predefined styles, table formats, head-
ers and footers, and more, this latest version of Word helps you create high-quality, ef-
fective documents you can share easily with others—in less time than it would take you
to wade through all the menus in Word 2003.

For an interesting behind-the-scenes look at the design choices that went into the
dramatic user interface changes in Microsoft Office 2007, see Office program man-
ager Julie Larson-Green'’s video on Channel 9: http://channel9.msdn.com/Showpost.
aspx?postid=114720.

A Whole New Way of Working: Word 2007 Changes

To say that the world has changed since the early days of Word for DOS would be a
huge understatement. Going to work in the early 1980s meant getting in the car (or on
the train) and traveling the half-hour to the office, where you would open your diary
and run your finger down the page, scanning the appointments you had made for first
thing in the morning. Meetings were always face-to-face or on the phone; most appoint-
ments with clients required driving; and reports, newsletters, and marketing materials
took weeks—if not months—and big budgets to produce.

Now fast-forward to 2007. The latest statistics we have on the world of work tell us

that, for example, in the United States, 20.8 million people did some amount of work at
home as part of their primary job. That includes almost 30 percent of workers in man-
agement, professional, and related roles. Additionally, approximately 1 in 5 sales profes-
sionals reported working from home.
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In addition to this flexible workplace, we have a global workforce. Companies may have
work teams or vendors all over the globe; you can draft a document in Seattle in the
morning and others may be reviewing it in Ireland, China, and New York by lunchtime.
Worldwide cooperative creative writing is possible with tools like Word used in con-
junction with Groove or SharePoint, either with a time lag or in realtime. We need to be
able to contact each other instantly and share files easily and securely.

Not only have the walls of our offices come down, but the obstacles that used to make
it difficult (and expensive!) to create high-color, professional quality documents have
all but been erased. Now many of us have the capacity for color printing on our desk-
tops (or at least down the hall). We can print our own reports, design and produce
newsletters, and customize our own mass mailings using our own know-how and the
software on our desktop (or laptop) PCs. The tasks that once required a whole team of
people—writer, designer, photographer, layout artist, proofreader—are now often being
completed by a single person (although the graphic art may not be as good!). This en-
ables us to create really fine documents at a fraction of the cost, in far less time, while
retaining control of the project by keeping it in-house.

What the Work World Needs Today

One of the huge challenges this kind of flexibility and power brings is that we can do so
much and do it so quickly that we need to be able to make quick decisions about what
we want and need to focus on right away. What task is really at hand, right now? Which
document should you work on this morning, knowing you need to do something com-
pletely different this afternoon? We need to be able to make choices about our priori-
ties and then act on them without a lot of clutter on our desktops or distractions in our
minds.

If you're like most of us, you know that’s not always an easy thing to do.

No matter what our roles at work, to be successful today, we need to somehow be able
to balance the following critical needs.

® To gather and process information accurately and efficiently to make sound busi-
ness decisions (and weed out the irrelevant data we receive)

e To connect with others (customers, vendors, employees, peers, managers, and
stakeholders) in a timely and effective way

® To learn about and use tools that help us complete tasks, manage relationships,
track business processes, and demonstrate professional results

e To produce quality materials that help move our company or department toward
its established goals (for example, increased awareness, improved client satisfac-
tion, enhanced partnerships)

Enter Word 2007

The teams responsible for the design of Microsoft Office have been listening and learn-
ing from users for years. Their research involves conducting detailed observation, data
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records, studies and focus groups; going out into the field and talking with users; and
gathering, reading, and analyzing the data they receive from those users who chose to
participate in the Office 2003 Customer Experience Improvement Program. The huge
changes you see in Microsoft Office 2007 are a direct result of what users have said
they need. Here’s a quick list of the design goals for the 2007 release as they specifically
relate to Word.

Make the product easier to use The first thing you'll notice about Word is that
the new design does away with the over-abundance of text-heavy toolbars and the
layers of nested dialog boxes. Word now brings you the tools you need to com-
plete the task you're working on. The tabs in the Ribbon (we’'ll cover this in more
detail in the next section) offer command sets that are related to the next step in
the natural process of creating a document, so finding the command you need
next is simple and intuitive.

Because the tools you see are related to the context in which you're working,
you're likely to discover tools you didn’t know about before. If you're adding a
header, for example, you will see how easy it is to create a different header for the
first page of a document, because the Ribbon displays all options related to head-
ers in one easy-to-see area (see Figure 1-1).

‘\ H92-0v )+ Documentd - Microsoft Word Header & Footer Toals
Home  Insert Page Layout References Mailings Review  View ‘| Design |‘
. . @ . . (5, Previous Section || [T Different First Page ﬁ. Header fromTop:  |0.5° |
| - 73
‘ ” 5, Next Section ‘I [E] Differertt Odd & Fuen Pages || B+ Faoter from Bottam: 05 %
Hesder Foter  Page Date Quick Picture cnp || Gote Goto E=—llae
v  Number+ | &Time Paits~ At || Header Footer 2 Link to Previous | [#] show Document Text || [B] msert 2lignment Tab g

Header & Footer | Insert | Navigation | Options 1 Position I

i
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Figure 1-1 The Ribbon displays the Header & Footer Tools contextual tab, which contains all
options related to headers so that you can find what you need easily when you add a header
to your document.

Chapter 1
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Getting

e Help you become more efficient The redesign saves you time by making the
options you need easier to find; the flexibility in the way you can now work with
Word (choosing primary mouse-based or keyboard-based techniques) enables
you to choose the work style you like best. Choosing templates is now easier
and more intuitive (and the selection is greatly expanded), and the addition of
many predesigned elements—cover pages, pull quotes, equations, sidebars, and
more—enables you to add professional elements to your page with a click of the
mouse button. Document Themes and Quick Parts (content you can customize to
fit your own document needs) make it easy to ensure that your document looks
professional quickly. File sizes are smaller, and expanded support for Windows
SharePoint Services makes it easier than ever to share files with others. If you en-
joy blogging you'll be pleased to know that you don't have to leave Word to add a
post to your favorite blog.

® Make it easier to find what you need Enhanced Tooltips help you understand
how a feature can be used and provide a link for more detailed help. Live Preview
lets you see the effect of a change (such as a style, font, or color) before you select
it. Galleries display a range of choices you can select quickly without digging
through multilayered menus. Additionally, Help is another feature that received
a facelift as result of user feedback. The new interface allows you to search online
and offline content with a click of the mouse and the Table of Contents is syn-
chronized with the displayed Help topic making it easier than ever to find the
answer to your query.

e Make it easier to create great professional quality documents In addition to the
expanded template collection that is available when you create a new document
in Word, you can now share your templates with others or display user-reviewed
templates as part of the selection process. Galleries and Live Preview show you
instantly what the predesigned content items—headers and footers, pull quotes,
sidebars, and more—will look like when you add them to your page. Choose from
among dozens of professionally designed color and font schemes, and add special
touches—such as shadows, rotation, and glow—to your pictures.

This list provides just a quick glimpse of some of the ways in which Word 2007 im-
proves and streamlines the way we can work today. As you begin to use the program,
however, the dramatic changes begin to sink in. Let’s start off by taking a closer look at
the Word 2007 window.

Familiar with the Word 2007 User Interface

The new design of the user interface throughout the primary Office 2007 applica-

tions has received a lot of press. Early reactions were generally positive—people were
intrigued by the idea that Microsoft Office designers went “back to the drawing
board”when they began brainstorming about the new look and feel of the latest design.
Power users were more wary of the design, wondering whether the new Ribbon would
take up too much room on the screen, and they were concerned that shortcut keys
would be lost in favor of design bells and whistles.
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Office 2007 Beta 2 was downloaded more than three million times in its first two
months of availability—that’s a lot of people, worldwide, testing out the new user inter-
face (UI)! Experienced users were weary—why fix what's not broken?—and power users
wondered whether the simplified design would make it impossible to use the shortcuts,
macros, and more they had come to rely on to expedite their document tasks.

John Obeto, editor of SmallBizVista.com and an experienced Office user, put it this
way when he was asked what he thought of the new Office 2007 design: “Liked it, then
hated it, now starting to really like it. Like the fact that I could do more without think-
ing initially, then started to hate the fact that a lot of my now conditioned (Pavlovian?)
responses/shortcuts were no longer effective. Furthermore, while a lot more commands
and functions are exposed, customization is now hidden several levels deep, prompt-
ing me to scream several times! However, more time spent on it, and breaking-in new
users on it, re-started the love affair, as training seems to be shorter, with more accom-

plished.”

At the end of the day, however, the positive response carried. New users were able to
find what they needed easily; and expert users—particularly those who are involved in
training other users—seemed happy with the level of flexibility and customization (and
the fact that they could continue using all their favorite shortcuts from Word 2003 in
their Word 2007 documents).

Find What You Need, Intuitively

When you open Word 2007 for the first time, you will immediately notice that the
screen looks more open and inviting. Instead of a line of menu names, you see graphical
representations of tools related to different sets of commands. Word 2007 is designed
to offer you commands in the way in which you're likely to need them. Figure 1-2 shows
the Word 2007 window. The sections that follow introduce you to each of the new ele-
ments in the Word 2007 interface.
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Figure 1-2 The Word 2007 window.

Exploring the Ribbon

You'll see the word Ribbon used to describe the new tool area stretching across the top
of the Word window. This is the place you'll find the commands you need when you
are working with your document in different ways. For example, when you create the
document, the Home tab provides the commands you are likely to use as you start out.
When you're ready to share your document with others, the Review tab offers a variety
of tools for preparing the file for review and working with the review copies when you
receive them. The Ribbon actually is made up of several important elements.

Command tabs (Home, Insert, Page Layout, References, Mailings, Review, and
View in Word 2007) stretch across the screen just below the window’s title bar.

Command sets are groups of commands available on the Ribbon when a specific
tab is selected. For example, when the Insert command tab is selected, the com-
mand sets displayed include Pages, Tables, Illustrations, Links, Header & Footer,
Text, and Symbols.

Contextual tabs help keep the window uncluttered by displaying task-related
tools only when an object is selected on the document. When you select a picture,
for example, the Picture Tools contextual tab appears along the top of the Ribbon.
The commands displayed when the contextual tab is selected all relate to the ob-
ject you've selected (see Figure 1-3).
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Figure 1-3 Contextual tool tabs appear above the Ribbon when an object is selected in the
document.

Note

The Ribbon is fully displayed by default when you begin working with Word 2007. If you
want to minimize the Ribbon to get maximum room on the screen, press Ctrl+F1. The
Ribbon reduces to the menu bar only. To redisplay the Ribbon, press Ctrl+F1 again. If you
want to reduce the display of the Ribbon to only the command tabs, you can double-
click any tab to minimize it. Then, to redisplay the full Ribbon, simply double-click any
command tab.

A Major Redesign for the File Menu

The File menu has been given a makeover as well. Now, instead of the word File ap-
pearing on the far left side of the window, you see the Microsoft Office 2007 logo. This
is called the Office Button. Changes from the old File menu aren’t simply cosmetic—the
new design includes two panels that add a whole new level of functionality. On the left,
you see the major file tasks, such as New, Open, Save, and Print; on the right, you see

Chapter 1
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subchoices of those major tasks. For example, when you position the mouse over Print,
the choices shown in Figure 1-4 appear.

’-fE_é\\“ H=9-0 )+ Documentl - Microsoft Worc

New

Print
Select a printer, number of copies, and ‘

7 Open other printing options before printing.

Preview and print the document

& Quick Print

Save Send the document directly to the default
printer without making changes.

N
y
|E_E ! =rde b Prln.t Preview
Preview and make changes to pages before
&

printing.

EE.}: Publish  »

Close

L)‘

[ 23 word options || X Exit word |

Figure 1-4 The Office Button provides you with additional choices when you select the major
commands.

One of the first things you'll see when you click the Office Button is the new expanded
Recent Documents list. This is a great way to get to your favorite documents directly,
without using the Open dialog box.

The order of the options in the Office Button follow the basic progression of the life
cycle of your document. Two great new additions include the Prepare command, which
provides you with options for completing the document, and the Publish command,
which includes commands that enable you to post to a blog, publish the document to a
document server, or share the document on a shared document workspace.

Choose File Tasks Quickly with the Quick Access Toolbar

Just to the right of the Office Button is a new feature called the Quick Access Toolbar.
On this toolbar, three familiar tools appear: Save, Undo, and Redo. You can customize
the Quick Access Toolbar to include other tools you use regularly. For example, if you
blog regularly, you can add the Blog tool to the Quick Access Toolbar. To add a tool,



Getting Familiar with the Word 2007 User Interface 11

click the Office Button and point to the Publish command. Then right-click the Blog
subcommand and select Add To Quick Access Toolbar (see Figure 1-5).
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Figure 1-5 Add your favorite tools to the Quick Access Toolbar.

If you add a number of tools on the Quick Access Toolbar, you may want to give it more
room by displaying the toolbar in its own row below the Ribbon. Right-click anywhere

on the Ribbon and choose Show Quick Access Toolbar Below The Ribbon. To return the
display of the toolbar to its original state, right-click the Quick Access Toolbar and choose
Show Quick Access Toolbar Above The Ribbon.

Using Dialog Launchers

The Ribbon is great for providing you with command sets that are related to the task

at hand, but at times you need to be able to choose from among a large selection of op-
tions. In those cases, having a traditional-style dialog box comes in handy. Dialog boxes
are available for some command sets on the Ribbon. You can tell which ones have a dia-
log box by looking for the small boxed arrow symbol, called a dialog launcher, in the
lower-right corner of a command set. For example, the Font command set on the Home
tab has a dialog launcher in the lower right corner. When you click the launcher, the
dialog box appears (Figure 1-6).
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Figure 1-6 Dialog launchers display dialog boxes.

Options for displaying dialog boxes are also available at the bottom of any gallery that
offers additional options. For example, when you choose the Page Layout command set
and click Columns, a gallery of column settings appears. Click the More Columns op-
tion at the bottom of the gallery to launch the Columns dialog box (see Figure 1-7).



Getting Familiar with the Word 2007 User Interface 13

Home Insert I Page Layout References Mailings
8 )y S
""" £ Line Numbers

Themes @ Halgms Dlzenialmn Slze ulum

h " Hyphenation
Themes Page Sg[

Two

Three

i
B

Right

EE  More Columns... |

Figure 1-7 Click the More command at the bottom of a gallery to display additional options.

Applying and Using Themes

One of the great additions to Word 2007 is a far-reaching, coordinated themes feature.
When you apply a theme to your Word document, the theme applies a set of coordi-
nated formatting choices—including fonts, colors, table styles, chart styles, special ef-
fects, and more—throughout your document. The beauty here is that you can apply and
change themes with literally a click of the mouse button, and the choices displayed in
the various galleries in Word are all coordinated to match the theme you have chosen
for the document.

You apply a theme to your document by clicking Themes in the Page Layout tab (see
Figure 1-8). The palette of themes appears so that you can click your choice. If you want
to change the theme later, you can simply return to the Themes gallery and click the
new theme you want to apply.

Chapter 1
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Figure 1-8 The theme you choose for your document helps you make formatting choices for all
the elements in your document with a single click.

Working with Galleries

Word now includes all sorts of galleries—Themes, Styles, WordArt, and more—that
graphically display a range of choices so that you can choose the design, color, layout,
and style that is right for your for the elements in your document. You will see galler-
ies displayed in different ways, depending on your screen resolution and the size of the
Word window. The Ribbon was designed to adjust to the size of the screen, so in some
cases you may see galleries appear as selections on the Ribbon, while other galleries
appear as drop-down items.

Basically, you'll see galleries represented two ways in Word. Some galleries are shown
as part of a command set in the Ribbon (similar to the Picture Styles gallery shown in
Figure 1-9); you can click the More button in the lower right corner of the gallery to
display the full collection of choices. Other galleries (such as the Themes, Margins, and
Position) display as drop-down galleries so that you can make your selection.
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Figure 1-9 Some galleries display a few choices in the command tab of a selected tab.

Other galleries open as a palette of choices, like the WordArt gallery shown in Figure
1-10. Using galleries, you can easily see at a glance which color combination, format,
color scheme, transition, or chart type you want. The choices you see in the galleries are
connected with the theme you've selected for your document, which helps you be sure
that when you're choosing a chart type, for example, it reflects the colors, fonts, and ef-
fects used in other parts of your document.

To choose an option in a gallery, simply click your choice and the setting is applied to
the current document or selected object.
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Figure 1-10 Some galleries open as palettes, enabling you to easily see which choice fits your
project.

Using Live Preview

Live Preview is a great new feature that lets you see how the effects of a change will
look before you choose it. When you point to an option in a menu or gallery (such as
the Quick Styles gallery shown in Figure 1-11), the effect is applied temporarily to your
document so that you can see how it will look. If you want to keep the change, click the
option. If you want to keep looking, point to a different option.
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Figure 1-11 Live Preview lets you see how a choice will look before you select it.

Note

Live Preview is especially helpful when you are trying to get just the right look for a spe-
cific item. Use Live Preview to quickly test out different styles, select chart options, add
shadow or glow to a picture, or choose another document theme, color, or background.

Making Quick Formatting Changes with the Mini Toolbar

If you're like other Word users, many of the choices you make while you're working on
a document have to do with formatting. Another new feature in Word 2007 brings the
most common formatting options to you so you don’t have to leave your creative zone to
choose the options you want. Whenever you select text, the new Mini Toolbar appears
above the text you selected (see Figure 1-12). If you want to use the Mini Toolbar, move
the mouse toward it and select the option you want; otherwise, move the mouse pointer
away and it fades out.
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Figure 1-12 The Mini Toolbar displays quick formatting choices whenever you select text.

If you find the Mini Toolbar distracting or don't think you'll use it, you can turn off the
feature by clicking the Office Button and choosing Word Options (in the lower-right
corner of the menu). In the Popular section, click the Show Mini Toolbar On Selection
checkbox to clear it. Then click OK. Now the Mini Toolbar is disabled and will not ap-
pear the next time you select text. (It will appear, however, when you right-click selected
text.) To reactivate the MiniToolbar, display the Options dialog box again and reselect the
checkbox.

Viewing Documents in Different Lights

While you're working on your document, you can easily change to a different view by
clicking one of the view tools in the bottom right corner of the Word window or by
clicking the View tab and choosing a view in the Document Views command set. You
can also use the new Zoom slider to enlarge or reduce the display of the document.
Word offers you many different ways to view your work, depending on the type of docu-
ment you're creating and the task at hand.

e Print Layout view seems to be the view most people use as they create and edit
their documents. This view, which is used by default when you create a new docu-
ment, shows how the document will look when printed. In this view, you can see
headers and footers, as well as footnotes and endnotes. The edges of the page and
the space between pages are also visible as you type and edit.

You can alternately suppress and display the top and bottom margins of your document
in Page Layout view by double-clicking the space between the pages. By default, Page
Layout view shows a gap between pages. Position the pointer over the page break, and
the pointer changes to two arrows. A tooltip prompts you to double-click the space to
remove it. Double-click at that point at the space between the pages is removed, en-
abling you to view text before and after the break in a continuous paragraph. To return
the page display to the default setting, position the pointer over the page break line and
double-click.
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e Full Screen Reading view gives you the maximum amount of space on the screen

so you can review and comment on the file. Note, however, that Full Screen Read-
ing view does not display the document as it will look in print—that’s the job of
Page Layout view. By default, when you first begin using Full Screen Reading
view, the functionality is limited to only reviewing and commenting. If you want
to be able to type and edit in Full Screen Reading view, click View Options in the
upper right corner of Full Screen Reading view and choose Allow Typing (see
Figure 1-13).
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Figure 1-13 Full Screen Reading view enables you to view, comment on, and edit your docu-
ment with a maximum amount of room on the screen.

Web Layout view displays the page as though it were a Web page. The first thing
you will notice when you select the Web Layout view tool is that the page margins
are not used, and depending on the content of your document, the format of your
document may seem skewed (see Figure 1-14).
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Figure 1-14 Web Layout view shows you what your document will look like as a Web page.

For more about creating and editing Web pages in Word, see Chapter 29, “Building Profes-
sional Web Sites.”

e OQutline view enables you to see the document in outline form, with headings and
subordinate text indented so that you can easily identify and work with sections
in a long document.

e Draft view (formerly known as Normal view) is a fast, no-bells-and-whistles mode
that many people prefer to use when they need to write or edit something quickly.
Note that some elements—such as headers and footers—are not visible while
you're working in Draft view.

Using Special Views: Document Map and Thumbnails

In addition to these five primary working views, Word 2007 enables you to use other
views to navigate through longer documents. The Document Map is a panel along the
left side of the work area that provides you with clickable headings so you can navigate
to different sections in your document (see Figure 1-15). This feature is really useful
when you are moving back and forth among sections.
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Figure 1-15 The Document Map gives you a panel of clickable headings you can use to navigate
among sections in a long or complex document.

Thumbnails view also enables you to easily see how your document is shaping up. When
you click Thumbnails in the Show/Hide command set of the View tab, the left panel
opens, displaying your document with the pages represented graphically. This is a great
view when layout is important and you want to create a sense of flow and variety in your
document (see Figure 1-16).
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Figure 1-16 Thumbnails view enables you to see miniature graphical representations of the pages
in your document.

A New View for Headers and Footers

Word 2007 provides expanded support for working with headers and footers. When
you create a header or footer (by clicking the Insert tab, choosing Header or Footer from
the Header & Footer command set, and choosing the design you want by selecting

it from the gallery), the header and footer area opens. The cursor is positioned in the
header or footer, and a full array of Header & Footer Tools are displayed in a contextual
tools tab in the Ribbon.
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This description provides just a quick look, but for more detail on adding and custom-
izing headers and footers, see Chapter 3, “Mastering Page Setup and Pagination.”

Displaying Rulers and Gridlines

When you are working on a document in which the alignment and sizing of elements is
important, you will want to turn on rulers and gridlines to make sure items line up on
the page and meet the measurements you need. The controls for both items are found in
the Show/Hide command set of the View tab.

There’s a new tool located at the top of the vertical scrollbar that enables you to display
and hide rulers quickly. The rulers are displayed by default, so to hide the rulers, posi-
tion the mouse on the View Ruler button and click. The rulers are removed. To redis-
play the rulers, click the tool a second time.

Alternately, you can display vertical and horizontal rulers by clicking the View tab and
then clicking the Ruler checkbox. To hide the rulers, click the Ruler checkbox to clear it.
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Note

If you don't like rulers cluttering up your work area and you want to remove the vertical
ruler in Print Layout view, you can turn it off using Word Options. Click the Office But-
ton and choose Word Options. Choose Advanced and scroll down to the Display options.
Click the last option in the group, Show Vertical Ruler In Page Layout View, to clear the
option's checkbox. Click OK to save your changes. When you return to Print Layout view,
the vertical ruler will be gone.

Adding gridlines is a similar process. Choose View and click the Gridlines checkbox.
Gridlines appear on your document so that you can easily align pictures, pull quotes, or
other elements on your page (see Figure 1-17).
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Figure 1-17 Gridlines enable you to align pictures, charts, and other elements in your document.

Viewing More Than One Page at a Time

The Zoom command set in the View tab includes five different tools that enable you
to change the size and number of pages you view on the screen at any one time. Page

Chapter 1
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Width view is selected by default, but you can easily change that to match your own
comfort level.

To change the size of the text, click the Zoom tool. The Zoom dialog box opens so that
you can choose one of the preset sizes or specify your own by clicking in the Percent
box and typing a new value (see Figure 1-18). You can also change the number of pages
displayed by clicking the Many Pages button and dragging to select the number of pag-
es you want to display on the screen. The Preview window shows you how your docu-
ment will look, and the sample text area shows how readable (or not!) your text will be.
When you've made changes you are happy with, click OK to save them.

Zoom ko
O 200% O Page width () Many pages:
O 100% O Text width
O 75% O whole page

Percent:

Preview

2 x 2 Pages

AzBRC

AsBRCcDAE=NxYviz

AsBRCcDAE=NxYviz

[ OK ][ Canicel ]

Figure 1-18 Use the Zoom dialog box to change the way your document is displayed.

Back on the View tab, you can switch among multipage views easily by clicking the One
Page, Two Pages, or Page Width tools. Each of these tools behaves the way you would
expect—One Page shows you the whole page at the cursor position; Two Pages displays
the page on which the cursor is active and the next full page in the document; and Page
Width magnifies or reduces the size of the document so it fits the width of the Word
window.

Working with Multiple Documents

When you are working on a big project, chances are that you will have more than one
document open at the same time. If you're copying and pasting your research notes into
anew journal article you're writing, or if you're incorporating the latest fundraising
figures in the annual report, you'll need an easy way of moving among open documents
while you work. The View tab includes the Window command set to give you the means
to do just that.

When you want to easily move among open Word documents, use the Switch Windows
tool. When you click Switch Windows, a menu shows you the various open windows;
just click the one you want to see.
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Use the New Windows command when you want to open a new copy of the current
document in a new window. You might use this command so you can edit different por-
tions of a large document at the same time instead of endlessly scrolling back and forth.
When you're ready to close the copy, click the Close button.

For more about reviewing, comparing, and merging documents, see Chapter 19, “Collaborat-
ing Online and Sharing Documents.”

The Arrange All, Split, and View Side By Side commands all enable you to choose how
you want to view the open documents. View Side By Side displays the Compare Side By
Side dialog box so that you can choose the other open document you want to compare
with the current one. Select your choice and click OK to display the document.

Compare Side by Side

Compare Side by Side with:

Coral Reef Divers Annual Report

OK ] L Cancel

Depending on the number of open document windows and your screen resolution, the
Ribbon may disappear when you use the Arrange All command. This is due to the auto
scale feature of the Ribbon. To return the view of the Ribbon, simply resize the height of
the document window.

When you use the View Side By Side command, Word sets the default to Synchronous
Scrolling, which means that as you scroll through one document, the other document
scrolls automatically. This is helpful for comparing documents in which you're looking
for paragraphs, sections, or even phrases that might be slightly different (see Figure 1-19).
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Figure 1-19 You can easily compare Word documents by using the tools in the Window command

set of the View tab.

Note

If you also like open documents to appear as a single task on your Windows Taskbar, you
can use Word Options to display them that way. Open the Office Button, choose Word
Options, and then click Advanced. Scroll down to the Display options and click Show All

Windows In The Taskbar to select it. Click OK to save your changes.

Understanding Status Bar Data and Tools

In previous versions of Word, the status bar was basically underutilized space. There
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were few controls housed there, and the status bar was not customizable, even though
it provided some helpful functions: you could view the page number, switch from Over-
type to Insert mode, or turn Tracking on and off. The customizable status bar in Word
2007 goes beyond providing a quick glimpse of your document’s key information—each
option displayed can be used to open dialog boxes or toggle various settings.
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Page: 23 of 28 | Words: 6,510 | O |

® The Page area shows the number of the current page and the length of your docu-
ment. You can also click this area to display the Go To tab in the Find and Re-
place dialog box.

e Now Word displays a continually updating word count on the status bar as well.
Click this area to see the Word Count dialog box and get additional statistics on
number of characters, paragraphs, and more.

® To detect errors, an ongoing spelling and grammar checker continuously reviews
your document content. Click to go to the error and see options for correcting it.

In addition to the controls that appear in the status bar by default, you can add or re-
move options by right-clicking anywhere on the bar. The Customize Status Bar menu
appears, giving you statistics about your document and showing you which features are
currently enabled (see Figure 1-20).

‘Customize Status Bar
Formatted Page Mumber 1
Section 1
|_i_| Page Mumber 1ofl
Vertical Page Position s
Line Number 1
Column 1
|Z| Word Count 0
|z| Spelling and Grammar Check Mo Errars
|z| Language
|E| Signatures Off
|_7_| Information Management Policy Off
iz| Permissions Off
Track Changes Off
Caps Lock Off
Overtype Insert
Selection Mode
Macro Recording Mot Recording
|El View Shartcuts
[v]| zoom 100%
|z| Zoom Slider

Figure 1-20 The Customize Status Bar menu allows you to add or remove additional options.

Controlling Word 2007 Options

You've already seen a few tips in this chapter that take you into the Word Options area.
Word Options has benefited from a major redesign and reorganization in this latest ver-
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sion of the program. Now you access Word Options by clicking the Office Button and
choosing Word Options in the bottom right corner of the menu.

The Word Options window offers you a collection of settings to change (see Figure
1-21). The Popular options are displayed by default, but you can choose from the fol-
lowing categories, depending on what you'd like to change: Display, Proofing, Save, Ad-
vanced, Customize, Add-Ins, Trust Center, and Resources. We cover Trust Center and
Resources in detail in the last two sections of this chapter, so we'll focus on the other
options now.

Word Options
o o & Change the most popular options in Word.
Display
Proofing Top options for working with Word
Save Show Mini Teolbar on selection &

Enable Live Preview (0
[[] show Developer tab in the Ribbon (i)
Customize Always use ClearType

Advanced

Add-dns Open e-mail attachments in Full Screen Reading view ()

SegeenTip style: |Srmwfeatuv= descriptions in ScreenTips v
Trust Center

Resources

Personalize your copy of Office

Username: | Katherine Murray
Chaose the languages you want to use with Office: | Language Settings...

CoJ Lo ]

Figure 1-21 Display the Word Options dialog box by opening the Office Button and clicking Word
Options in the bottom right corner of the menu.

Here’s a quick rundown of what you'll find in each of the Word Options categories.

e Popular includes options for setting up Word the way you like it—choosing
whether to turn off Live Preview and the Mini Toolbar, use ClearType, and display
attachments opened from e-mail in Full Screen Reading view. It also allows you to
personalize Word with your user name, initials, and set language choices.

e Display options include controlling the way the page appears (do you want white
space to appear between pages in Page Layout view?), choosing whether you want
formatting marks to show up on the screen, and specifying a number of print
options.
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® Proofing controls the options for working with AutoCorrect and setting up your
choices for the spelling checker and the grammar checker. Additionally, you can
indicate exceptions you want to apply to specific files.

® Save enables you to specify where you want to save your Word documents by
default. Additionally, you can indicate how you want documents you share with
others—or post to a document management server—to be saved and updated. The
Save category also enables you to choose whether you want to embed fonts in
your document so that others viewing your file will have access to the same fonts
whether or not they are installed on their systems.

Embedding fonts in your Word documents increases the size of the file.

e Advanced covers many options related to a variety of tasks in Word. You'll find
options for editing; cut, copy, and paste; display; saving (these are different op-
tions from the ones shown in the Save category); printing; XML; and compatibil-
ity. You can also choose the number of documents that are listed in the Recent
Documents list.

e (Customize provides you with options for customizing the Quick Access Toolbar
and setting up your own keyboard shortcuts.

e Add-Ins enables you to manage add-in programs that come with Word 2007 and
those that you have added.

Setting Up the Microsoft Word Trust Center

The Microsoft Office Word Trust Center is a new feature in Word 2007 that provides
enhanced privacy and security options when you are working with files from other
sources or sharing the files you create

To display the Trust Center, click the Office Button and choose Word Options. Click
Trust Center.

The opening screen of the Trust Center provides you with a series of links concerning
privacy and security. Click the Trust Center Settings button on this first screen to see
the full range of choices available to you (see Figure 1-22). The following list describes
the types of items you can set up in each of the Trust Center categories.
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Trust Center,

Trusted Publishers Privacy Opfions
Trusted Locations

Add-ins [[] Show Microsoft Office Online featured links (1

ActiveX Settings Download a file periodically that helps determine system problems ()
Sign up for the Customer Experience Improvement Program ()
Macra Settings
Read our privacy statement
Message Bar

Search Microsoft Office Online for Help content when I'm connected to the Internet (0

Document-specific settings

A

[[] Warn before printing, saving or sending a file that contains tracked changes or comments
Stare random number to improve merge accuracy

ake hidden markup visible when opening or saving

Document Inspector.

Research & Reference

Translation Options...
Research Options...

[ox J (Comnen ]

Figure 1-22 The Trust Center provides you with a number of categories you can use to protect
your files and your computer system.

® Trusted Publishers enables you to specify which publishers of information, add-

ins, and more you deem to be trustworthy. Only add people and organizations
you know to be secure (it’s better to be prompted each time you open a file if
there’s any chance that a file might be corrupt or have a virus attached). When
you specify a publisher as a Trusted Publisher, Word automatically trusts macros
in any files from that source.

Trusted Locations is a list of acceptable locations and sites you trust. The loca-
tions may store documents or templates that include macros. You can add new
locations, modify existing locations, and remove locations using this setting.
When you open a document or template from a trusted location, the macros will
be enabled automatically and you won'’t be prompted to enable or disable them.

Add-Ins controls the way in which Word treats all third-party add-in utilities.
There are three options in this setting: You can insist that all add-ins be digitally
signed by the publisher, be prompted when an add-in is unsigned (the code will
be blocked), or disallow all add-ins.

ActiveX Settings lets you control how you want Word to handle all Microsoft
ActiveX controls that are not recognized as being from a trusted source. Options
range from disallowing the ActiveX controls to running in Safe Mode with
restrictions.
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® Macro Settings gives you options to control whether the macros you run in a
document must be from a trusted source and digitally signed. You also have the
option of enabling all macros (which isn’t recommended) or disabling all macros.

® Message Bar settings enable you to specify when you want the Trust Center to

display alerts in the Message Bar that appears just below the Ribbon. When you
are opening a file from a questionable source, the Message Bar tells you that the
source is not trusted and gives you options for proceeding. The Message Bar set-
tings in the Trust Center give you the option of turning this notification off (it is
turned on by default). Additionally, the Allow Trust Center Logging check box at
the bottom of this screen gives you the choice of logging all notifications you re-
ceive in the Message Bar.

e Privacy Options provides you with settings that enable you to choose whether
Word connects to the Internet when you search for help, whether files can be
periodically downloaded to log problems with the software, and whether you are
signed up for the Customer Experience Improvement Program. Additionally, you
can choose document-specific settings (such as whether you are alerted before
you send or print a document that has comments and tracking turned on) and
translation and research options.

If you're interested in setting up parental controls for your version of Word, go to the
Trust Center and click Privacy And Research Options. Parental Control is available in the
lower-right corner of the Research Options dialog box.

Using Your Word Resources

The last option in the Word Options dialog box is Resources. This is where you'll find
links to enhance, improve, and—if necessary—fix the way Word operates. The Resources
window is shown in Figure 1-23. As you can see, this is where you go when you want to
get the latest update for your version of Microsoft Office, repair a problem you're hav-
ing with Word, get contact information for tech support, activate your version of the
program (the button will still say Activate even after your software has been activated),
register for online classes, and more.
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Word Options 2
Popular [l Contact Microsoft, find online resources, and maintain health and reliability of your Microsoft Office
L9 programs.
Display
Proofing get updates Check for Updates
Save Get the latest updates available for Microsoft Office,
Advanced run Microsoft Office Diagnostics
Customize Diagnose and repair problems with your Microsoft Office programs,
Add-Ins contact us Contadt Us
Trust Center Let us know if you need help, or how we can make Micrasoft Office better,
hmm' - ——q activate Microsoft Office
Activation is required ta continue using all the features in this product.
go to Microsoft Office Online
Get free product updates, help, and online services at Micrasoft Office Online.
about Microsoft Office Word 2007

Microsoft® Office Ward 2007 (12,0 4518.1014) MSO (12.0.4518.1014)

o

Figure 1-23 The Resources category in the Word Options dialog box enables you to get program
updates, diagnose problems, and more.

And if you were wondering where in the world the About box went (formerly it was in
the Help menu of all applications), here it is, tucked away at the bottom of the
Resources list.

What's Next

This chapter introduced you to the way in which the working world has changed since
the earliest versions of Word and brought you up-to-date by introducing the major new
features in the Word 2007 release. The next chapter shows you how Word 2007 fits
naturally into the life cycle of your documents—large and small—and gives you ideas
for ways in which you can streamline your creative process, whether you're working on
your own or as part of a team.



